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Adobe Photoshop 
 
Pengenalan Photoshop 
 
Adobe photoshop adalah suatu program aplikasi untuk desain dan manipulasi 
image atau photo. Dengan photoshop kita dapat dengan mudah mengedit 
gambar, mengubah ukuran, memotong gambar, menggabungkan gambar, 
mengubah brightness dan contrast, mengubah format gambar dari format yang 
satu ke format yang lain, menambahkan efek tertentu pada gambar serta 
memberikan sentuhan-sentuhan artistic lain sehingga gambar terlihat lebih 
menarik. Bahkan dengan Adobe Photoshop CS, kita dapat meningkatkan 
kualitas dari foto yang rusak, salah potret, dan lain-lain sebagainya. Adobe 

Photoshop juga (beserta pasangannya Image Ready) merupakan salah satu 
aplikasi yang banyak digunakan untuk web graphic desain, dikarenakan fungsi 
grafisnya yang berlimpah dan kemampuan untuk menggenerasi sebuah 
halaman web utuh hanya dengan menggunakan fungsi dari Image Ready yang 
sebagian telah terintegrasi dalam Photoshop. 
 

Area Kerja Photoshop 
 
Area kerja di photoshop terdiri atas lima bagian yaitu menu bar, Option Bar, 
Pallete, Toolbox, dan canvas. Untuk lebih jelasnya dapat dilihat pada gambar 
dibawah ini. 
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Berikut ini adalah penjelasan dari gambar diatas 
1. Canvas seperti dalam kegiatan melukis adalah area atau layar yang akan 

digunakan untuk meletakkan objek-objek dalam adobe photoshop, dalam 
hal ini image yang akan di edit atau dimanipulasi. 

2. Menu Bar, berisi perintah-perintah dasar potoshop (menyimpan, mencetak, 
membuka file dan lain-lain ) serta perintah-perintah pengeditan dan 
manipulasi grafik. Menu dikelompokkan berdasarkan fungsinya. 
Contohnya, menu layer berisi perintah untuk bekerja pada layer. 

3. Option Bar. Digunakan untuk memilih setting yang akan berubah sesuai 
dengan tool yang diaktifkan. Contohnya, klik pada tool Rectangular 
Marquee, akan tampil opsi-opsi yang berhubungan dengan rectangle tool 
pada bagian option bar ini, apabila berganti memakai tool lain, maka isi 
dari option bar akan mengikuti dengan parameter-parameter yang dimiliki 
oleh tool yang bersangkutan yang sedang aktif atau dipakai. 

4. Toolbox. berisi tool yang digunakan untuk membuat, mengedit dan 
memanipulasi gambar. Contohnya, tool Elliptical Marquee untuk membuat 
seleksi berbentuk elips atau lingkaran. 

5. Pallete, digunakan untuk membantu dalam mengubah, mengatur dan 
memilih berbagai parameter penyuntingan dan pengolahan gambar. Contoh 
Pallete Layer dapat menampilkan semua layer yang ada dalam sebuah 
gambar. 

 

Toolbox 
 
Toolbox adalah floating bar yang berisi kumpulan tool-tool atau alat-alat yang 
tersedia pada aplikasi photoshop untuk digunakan digunakan desainer untuk 
menggambar, memberi warna, memilih, memodifikasi gambar dan membuat 
teks atau fitur-fitur laen yang diberikan. Beberapa tool mempunyai subtool di 
dalamnya yang ditandai dengan segitiga kecil yang berwarna hitam di sudut 
kanan bawah tool tersebut. Sub tool dapat diakses atau diaktifkan dengan 
melakukan klik kanan mouse pada posisi kursor berada pada icon tool yang 
memiliki sub tool. Kemudian akan muncul floating bar baru yang berisi 
seluruh sub tool pada kategori tool tersebut, untuk mengganti tool utama yang 
aktif pada kategori tool tersebut, sorot salah satu tool pada floating bar sub 
tool, lalu tekan tombol kiri mouse. Berikut adalah keterangan dari tool-tool 
yang berada di dalam toolbox beserta fungsinya. 
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 Move 
Berfungsi untuk memindahkan seleksi, layer yang sedang aktif dan 
membuat garis bantu. 
 

 
 Marquee tools, terdiri atas :   
 a. Rectangular Marquee 

Berfungsi untuk membuat seleksi berbentuk kotak atau segi empat. 
 b. Elliptical Marquee 

Berfungsi untuk membuat seleksi berbentuk ellips atau lingkaran 
 c. Single Row Marquee 
  Berfungsi untuk membuat seleksi horizontal sebesar satu pixel. 
 d. Single column marque 
  Berfungsi untuk membuat seleksi vertikal sebesar satu pixel. 
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 Lasso tool 
 Berfungsi untuk membuat seleksi bebas. 

 Polygonal lasso tool 
 Berfungsi untuk membuat seleksi berbentuk poligon atau segi banyak. 

 Magnetic lasso tool 
Berfungsi untuk membuat seleksi yang melekat atau menempel pada 
bentuk luar obyek yang dipilih. 

 Magic wand tool 
 Berfungsi untuk membuat seleksi berdasarkan warna yang ada pada 
gambar. 

 Crop tool 
Berfungsi untuk memotong atau membuang area yang tidak dinginkan 
pada gambar. 
 

 
 Slice tool 
 Berfungsi untuk membuat slice atau membagi-bagi gambar menjadi 
terpisah. 

 Slice select tool 
 Berfungsi untuk menyeleksi suatu slice. 
 

 
 Healing brush tool 

Berfungsi untuk menghilangkan atau mengganti bagian tertentu gambar 
yang tidak dinginkan. 

 Patch tool 
Berfungsi untuk menghilangkan bagian yang ingindibuang dengan cara 
menggesernya. 

 Color replacement tool 
Berfungsi untuk mengganti suatu warna dalam image dengan warna lain 
sesuai pilihan. 

 

 
 Brush tool 
 Berfungsi untuk menggambar dalam bentuk cat dengan kuas. 

 Pencil tool 
 Berfungsi untuk menggambar goresan seperti pensil. 
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 Clone stamp tool 

Berfungsi untuk melakukan duplikasi area tertentu dari gambar ke bagian 
area lainnya. 

 Pattern stamp tool 
 Berfungsi untuk melakukan duplikasi bentuk pola. 

  
 History brush tool 
 Berfungsi untuk melakukan undo bertingkat. 

 Art history brush tool 
Berfungsi untuk melakukan undo bertingkat dan untuk menambah 
sentuhan seni sehingga menghasilkan warna dan efek yang berbeda dari 
history aslinya. 

 

  
 Eraser tool 
 Berfungsi untuk menghapus area yang tidak diinginkan. 

 Background eraser tool 
 Berfungsi untuk menghapus area background dari gambar. 

 Magic eraser tool 
Berfungsi untuk melakukan seleksi secara otomatis seperti magic wand dan 
langsung menghapusnya menjadi transparan. 

 

  
 Gradient tool 
 Berfungsi untuk memberi warna gradasi pada gambar. 

 Paint bucket tool 
 Berfungsi untuk memberi warna pada gambar. 
 

  
 Blur tool 
 Berfungsi untuk mengaburkan gambar. 

 Sharpen tool 
 Berfungsi untuk menambah ketajaman gambar. 

 Smudge tool 
Berfungsi untuk memberi efek seperti gosokan jari tangan pada lukisan cat. 
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 Dodge tool 
 Berfungsi untuk mengatur pencahayaan agar lebih terang. 

 Burn tool 
 Berfungsi untuk mengatur pencahayaan agar lebih gelap. 

 Sponge tool 
 Berfungsi untuk mengatur tingkat saturasi pada gambar. 
 

  
 Path selection tool 
 Berfungsi untuk memilih dan menampilkan titik pada path. 

 Direct selection tool 
Berfungsi untuk memilih dan menampilkan direction point pada path. 
 

 
 Horizontal type tool 
 Berfungsi untuk membuat tulisan secara mendatar. 

 Vertical type tool 
 Berfungsi untuk membuat tulisan secara vertikal. 

 Horizontal type mask tool 
 Berfungsi untuk membuat tulisan dlam moe mask secara mendatar. 

 Vertical type mask tool 
 Berfungsi untuk membuat tulisan dalam mode mask secara vertikal. 
 

 
 Pen tool 

Berfungsi untuk membuat path (jalur) terbuka maupun tertutup dengan 
bentuk yang bermacam-macam baik garis lurus maupun lengkungan. 

 Freeform pen tool 
 Berfungsi untuk menggambar path secara bebas. 
 

 Add anchor point tool 
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 Berfungsi untuk menambah titik hubung/acu pada path yang sudah 
dibuat. 

 Delete anchor point tool 
 Berfungsi untuk menghapus titik hubung/acu pada path yang sudah 
dibuat. 

 Convert point tool 
 Berfungsi untuk memanipulasi path yang sudah dibuat. 
 

  
 Rectangle tool 
 Berfungsi untuk membuat bentuk segi empat. 

 Rounded rectangule tool 
 Berfungsi untuk membuat bentuk segiempat dengan sudut tumpul. 

 Eclipse tool 
 Berfungsi untuk membuat bentuk elips atau lingkaran. 

 Polygon tool 
 Berfungsi untuk membuat bentuk poligon atau segibanyak. 

 Line tool 
 Berfungsi untuk membut bentuk garis. 

 Custom shape tool 
Berfungsi untuk membuat bentuk yang lebih kompleks. (path buatan pen 
tool dapat juga disimpan sebagai custom tool dipakai seterusnya). 
 

 
 Notes tool 
 Berfungsi untuk membuat catatan atau keterangan. 

 Audio annotation tool 
 Berfungsi untuk membuat keterangan dalam bentuk suara. 
 

  
 Eyedropper tool 
 Berfungsi untuk memilih warna foreground atau background pada gambar. 

 Color sampler tool 
 Berfungsi untuk melihat nilai warna pada suatu area tertentu dari gambar. 

 Measure tool 
 Berfungsi untuk untuk mengukur jarak dan sudut gambar. 
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 Zoom tool 
Berfungsi untuk melakukan pembesaran atau pengecilan pandangan 
gambar pada kanvas. 

 Hand tool 
Berfungsi untuk memindahkan pandangan gambar pada area kanvas (bila 
zoom hingga kanvas ada yang tersembunyi). 

 Set foreground color 
Tombol foreground color berada di depan yang berfungsi untuk mengubah 
warna foreground. 

 Set background color 
Tombol background colour berada di belakang yang berfungsi untuk 
mengubah warna background. 

 Switch foreground and background colors 
Tombol untuk menukar warna foreground dan background yang sedang 
aktif satu sama lain, sehingga warna foreground menjadi warna background 
dan sebaliknya. 

 Default foreground and background color 
Mengubah warna foreground dan background menjadi warna default yaitu 
hitam untuk foreground dan putih untuk background). 

 Edit in standard mode 
 Berfungsi untuk menggunakan tampilan mode standar. 

 Edit in quick mask mode 
 Berfungsi untuk menggunakan mode tampilan dengan efek mask secara 
cepat. 

 Standard screen mode 
 Berfungsi untuk mengaktifkan window standar. 

 Full screen with menu bar 
Berfungsi untuk mengaktifkan jendela tampilan penuh satu layer dengan 
menu bar-nya. 

 Full screen mode 
 Berfungsi untuk mengaktifkan jendela tampilan penuh atau layer tanpa 
menu  bar. 

 Edit in image ready 
Berfungsi untuk melakukan editing gambar yang sedang aktif lebih lanjut. 
Pada aplikasi Image Ready. 

 

Pallete 
 
Pallete, adalah suatu wadah bagi pengaturanpengaturan parameter dan status 

fitur-fitur yang ada pada photoshop. Misalkan saja, warna, sejarah (history) 
editing, layer, dan lain-lain. Untuk menampilkan palet, klik menu Window lalu 
pilih pallette yang diinginkan. Misalnya, akan menampilkan pallette Color, kilk 
menu Window > Color. 
Untuk memilih pallette yang lain yang ada dalam satu kelompok, klik pada tab 
palet yang diinginkan. 

 Palet Layers.  
Palet ini digunakan untuk menampilkan semua layer yang ada dalam 
sebuah gambar. Dalam palet Layers dapat dilakukan pengubahan urutan 
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layer, menghapus, membuat layer baru, menduplikasi sebuah layer, 
menampilkan atau menyembunyikan layer dan sebagainya.  

 

 Palet  Channels. 
Palet ini digunkan untuk menampilkan chanel-chanel yang berfungsi untuk 
menyimpan informasi warna. Dalam palet Chanels dapat dilakukan 
penyimpanan seleksi, pembuatan alpha chanels dan menampilkannya. 

 
 Palet Paths. 

Palet ini digunakan untuk membuat, menduplikasi, menghapus 
mengaktifkan dan mengatur path. Path adalah objek yang dibuat dengan 
merangkai beberapa garis lengkung dan garis lurus dari stu titik ke titik 
yang lain. 

 

 Palet History. 
Palet ini digunakan untuk menyimpan status perubahan yang dilakukan 
pada sebuah gambar, sehingga dapat dilakukan koreksi kesalahan atau 
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undo terhadap perubahan tersebut. Undo dapat dilakukan satu tahpa atau 
lebih dari serangkaian proses penyuntingan gambar yang telah dilakukan. 

 

 Palet  Action. 
Palet ini digunakan untuk merekam serangkaian perintah sehingga dapat 
mengotomasi pekerjaan dengan mengelompokkan perintah-perintah ke 
dalam sebuah aksi dan memainkannya. Palet action juga dapat digunakan 
untuk membuat dan mengakses tombol-tombol shortcut. 

 

 Palet Character. 
Palet ini digunakan untuk mengatur format atribut character, sehingga 
mempermudah dalam pengeditan manipulasi tulisan. 
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 Palet Pharagraph. 
Palet ini digunakan untuk mengatur format dan atribut paragraph, 
sehingga mempermudah utuk mengubah paragraph. 

 

 Palet Navigator. 
Palet ini digunakn untuk memindahkan tampilan gambar yang ada di 
canvas ke dalam navigator, sehingga dapat dilakukan pengubahan ukuran 
tampilan gambar secara cepat menggunakan slider yang terdapat di bagian 
bawah jendela palet navigator.  

 

 Palet Info. 
Palet ini digunakan untuk menampilkan informasi mengenai nilai komposisi 
warna dan informasi mengenai posisi pointer pada gambar. 
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 Palet Color. 
Palet ini digunakan untuk membuat, mencampur dan memilih warna baik 
untuk foreground maupun background. 

 

 Palet Swatches. 
Palet ini digunakan untuk mengoleksi warna dan memilih campuran warna-
warna yang sudah tersedia, masing-masing campuran warna dapat 
ditambah, disimpan dan dihapus melalui menu pada palet swatchnes. 

 

 Palet Styles. 
Palet ini digunakan untuk menerapkan kombinasi efek-efek yang terakhir 
kali digunakan dan efek-efek yang telah disediakan oleh photoshop. Dalam 
palet styles dapat dilakukan penyimpanan, pengambilan dan penghapusan 
style. 

Layer 
 
Pada Photoshop, salah satu fitur yang sangat memudahkan dan membantu 
dalam editing dan desain adalah fitur layer, yang dimana image dapat tersusun 
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dari tumpukan-tumpukan image-image yang menjadi satu saling tumpang 
tindih namun tidak saling mengganggu. Oleh karena itu, saat berurusan 
dengan desain pada 
photoshop, seorang desainer akan selalu berhubungan dengan palette layer 
untuk bisa mendapatkan hasil yang maksimal. Fungsi layering (tingkatan) 
sangat berguna, karena dengan adanyA layering, iamge dapat diedit.diubah 
perbagian, sehingga tidak mempengaruhi bagian-bagian image yang laiinya. 
Semisal saja melakukan editing desain sebuah rumah dan alam sekitarnya, 
image yang terdiri dari layer-layer, dapat diedit satu persatu, saat melakukan 
editing pada layer pohon misalnya, apabila menghapus bagian tertentu dari 
pohon, tidak akan meninggalkan lubang, karena pada layer dibawahnya ada 
image rumah, dimana memang seharusnya terlihat jika bagian pohon tertentu 
di potong/dikurangi. Tidak seperti image konvensional yang akan 
meninggalkan lubang putih karena penghapusan image pohon. 
 

 
Keterangan : 

 Layer blending mode 
Menentukan jenis blending mode layer yang aktif pada susunan 
keseluruhan layer. 

 Layer lock 
Mengunci layer dari aktifitas tertentu. 
a. Transparant lock 

Mengunci bagian transparan dari layer, sehingga bagian transparan 
tidak dapat diedit. 

b. Pixel lock 
Mengunci bagian layer yang terisi oleh data/pixel image, sehingga 
bagian tersebut tidak dapat diedit. 

c. Move lock 
 Mengunci layer sehingga tidak dapat dirubah posisinya pada kanvas. 
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d. Lock all 
 Mengunci layer dari smeua aktifitas 

 Visibility status 
Status dari layer apakah layer tersebut ditampilkan pada kanvas atau 
tidak. Status ini ditandai dengan icon “mata” yang ada disamping kiri 
layer aktif, adanya icon tersebut ,menandakan status layer adalah 
terlihat. 

 Add layer style 
Menambahkan layer style yang terdiri dari beberapa jenis efek tertentu 
pada layer yang sedang aktif/diedit. 

 Add layer mask 
Menambahkan layer mask pada layer yang sedang aktif/diedit. 

 Create new set 
Menciptakan suatu set dapat dianalogikan sebagai sebuah folder yang 
menampung beberapa layer menjadi satu set atau satu kelompok, 
sehingga memudahkan editing. Karena pada desain tingkat advance 
atau pada web designing, hampir tidak mungkin melakukan designing 
dengan hanya menggunakan 3 atau 4 layer, tapi bisa menggunakan 
hingga belasan bahkan puluhan layer. 

 Create new fill or adjustment layer 
Menciptakan layer khusus untuk memperbaiki tampilan layer-layer lain 
(dibawahnya) seperti pengaturan hue dan saturasi, keseimbangan 
warna, dan lain-lain. 

 Create new layer 
Membuat layer baru yang kosong. Layer akan otomatis tercipta tepat 
diatas layer yang sedang aktif. Apabila layer yang sedang aktif di 
drag/tarik menujuicon ini, maka yang terjadi adalah proses duplikasi 
layer yang sedang aktif dan bukan membuat layer baru yang kosong. 

 Delete layer 
Untuk menghapus layer yang sedang aktif. Dapat dilakukan dengan 
menekan icon ini atau menarik/drag layer aktif pada icon ini. 

 Layer aktif 
Layer yang sedang aktif atau sedang diedit. Layer yang aktif akan di 
highlight oleh photoshop dan disamping kiri terdapat icon brush yang 
menandakan bahwa layer ini yang sedang aktif. 

 Layer quick menu 
Tombol untuk mengakses menu-menu pada fungsi layer, seperti merge 
down, merge visible, add layer mask,dan lain-lain. 

 Opacity level 
Menentukan tingkat opasiti layer yang aktif. Pada opasiti 100% maka 
bagian layer akan terlihat seluruhnya baik efek/style yang diaktifkan 
pada layer tersebut maupun image yang ada pada layer tersebut (jika fill 
layer tidak 0%) dan apabila opasiti 0% maka semua tidak akan terlihat. 

 Fill level 
Menentukan tingkat opasity dari fill/isian warna pada layer, akan tetapi 
fill tidak mempengaruhi style yang diaktifkan pada layer (misal stroke, 
bevel & emboss, atau gradient overlay) tetapi hanya image/pixel yang 
ada pada layer. 

 



 15 

 

Filter 
 
Keunggulan lain yang di usung oleh aplikasi pengolah grafis dari Adobe ini 
adalah banyaknya filter yang siap dipakai untuk menciptakan efek-efek khusus 
layaknya dalam fotografi professional. Untuk dapat 
menggunakan/menambahkan filter pada image/layer aktif, maka perlu 
dieprhatikan bahwa image harus berada dalam format warna Grayscale, RGB 
Color, CMYK Color, Lab Color atau Multichannel. Jika image memiliki format 
warna Indexed Color, maka gambar tersebut harus dikonversi terlebih dahulu. 
Hal ini dapat dilakukan pada menu Image >> Mode >> . . . 
Penggunaan filter merupakan inovasi yang sangat menarik, akan tetapi 
desainer grafis professional jarang hanya berpaku pada penggunaan filter saja 
untuk desain-desainnya, akan tetapi berhubungan dengan banyak efek, 
gabungan berbagai filter, bisa 3 atau bahkan belasan filter secara bergantian 
untuk menciptakan efek yang diinginkan. 
 
 

Mulai Bekerja dengan Photoshop 
 

Efek Outline 
 

1. Buat file baru dengan ukuran 325x125, resolusi 72. 
2. Buat tulisan, lalu pilih Select >> Modify >> Expand dan isikan dengan 

2. 
3. Buat layer baru dibawah teks, pilih warna pada foreground color lalu 

tekan ALT+Delete. 
4. Buat layer baru diatas background layer, lalu pilih Select >> Modify >> 

Expand dan isikan dengan 1. 
5. pilih warna pada foreground color lalu tekan ALT+Delete. 

 

 
 
 

Efek Alien 
 

1. Buat file baru, pilih warna hijau terang untuk warna Foreground dan 
hitam untuk warna background. 

2. Pilih Edit >> Fill >> Background Color untuk membuat layer 
background menajadi hitam. 

3. Pilih Type Tool >> Type Mask Tool pada toolbar lalu klik di dalam 
dokumen dan tulis teks. 

4. Pilih Edit >> Fill >> Foreground Color. 
 



 16 

 
 
5. Pilih Select >> Feather  2 piksel. 
6. Pilih Filter >> Blur >> Radial Blur (100, Zoom, Best). 
7. Ulangi langkah ke 7 atau tekan CTRL+F. 
8. Pilih Select >> Inverse. 
9. Pilih Filter >> Blur >> Radial Blur (100, Zoom, Best). 
 

 
 

Efek Gel 
 

1. Buat file baru dan isikan tulisan (huruf: Arial Reounded MT Bold, 
Challenge Extra Bold, Comic Sans MS, atau GoodDogPlain). 

2. Pilih Layer >> Rasterize >> Type. 
3. CTRL+Click pada layer untuk memilih teks. 
4. Buat layer baru diatas teks, lalu pilih Select >> Modify >> Contrast dan 

pilih antara 2-5. 
5. Pilih warna yang lebih terang dari warna teks, lalu tekan ALT+Delete 

untuk mengisi pilihan. 
6. Pilih Filter >> Blur >> Gaussian Blur dan pilih sekitar 2.0. 
7. Kembali ke layer teks awal, pilih Layer >> Layer Style >> Bevel and 

Emboss. Gunakan setingan berikut ini 

 Style : Inner Bevel 

 Technique : Smooth 

 Depth:61% 

 Direction:Up 

 Size: 8 

 Soften: 0 

 Hilangkan cek pada use global light 

 Altitide: 30 

 Gloss Contour: Rolling Slope 

 Highlight: Screen with 100% 

 Shadow: Multiply with 100% 
8. Masih tetap pada window layer style, pilih Drop Shadow dan Inner 

Shadow 
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Efek Api 
 

1. Buat file baru dan buat tulisan warna hitam. 
2. Buat duplikat layer teks tersebut dengan cara klik kanan pada layer teks 

dan pilih duplicate layer. Sembunyikan layer yang baru tersebut. 
3. Klik pada layer backgroud dan pilih Edit >> Fill >> Background Color. 

Sehingga background menjadi hitam. 
4. Klik kanan pada layer text, lalu pilih Rasterize Type. 
5. CTRL+Klik pada layer teks, lalu pilih Edit >> Fill >> Foreground Color. 
 

 
 

6. Selanjutnya pilih Filter >> Stylize >> Wind (wind, from left). Ulangi 
langkah tersebut dengan menekan CTRL+F. 

7. Selanjutnya pilih Filter >> Stylize >> Wind (wind, from right). Ulangi 
langkah tersebut dengan menekan CTRL+F. 

8. Pilih Image >> Rotate Canvas >> 90oCCW. 
9. Ulangi langkah 6 dan 7. 
10. Pilih Image >> Rotate Canvas >> 90oCW. 
11. Pilih Filter >> Blur >> Gaussian Blur dengan isi 2, lalu pilih Filter >> 

Distort >> Riple. 
12. Klik kanan pada layer teks, pilih merge down. 
13. Tampilkan kembali layer hasil duplikat, lalu klik kanan pada layer 

tersebut dan pilih Rasterize Type. Klik kanan sekali lagi dan pilih Flatten 
Image. 

14. Pilih Image >> Mode >> Grayscale. 

15. Pilih Image >> Mode >> Indexed Color. 
16. Pilih Image >> Mode >> Color Table dan pilih Black Body. 
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Teks Berbayang 
 

1. Buat sebuah file baru dengan luas 250*150 pixel dengan warna 
background putih (File | New). Setelah itu buatlah sebuah tulisan yang 
anda inginkan dengan Type Tool. 

2. Pilih menu Layer | Type | Render Layer… 
Select | All 
Edit | Cut 
Edit | Paste 

3. Tekan dan tahan tombol Ctrl dan klik pada palette layer sebuah layer 
yang berisi teks, selanjutnya pilih menu Select | Save Selection dan save 
as “New”. Ctrl+D (deselect) dan hapus layer yang berisi teks tersebut. 

4. Pilih panel “Channel-Palette” dengan pilihan yang telah anda simpan 
tadi (New). 

5. Pilih menu Filter | Blur | Gaussian Blur dengan nilai 2,5. 
6. Pilih menu Filter | Stylize | Glowing Edges dengan nilai “Edge width=1”, 

Edge brightness=8”, “Smoothness=3”. 
7. Ambil channel tersebut sebagai pilihan dengan mengklik tombol “Load 

channel as selection" di bawah channel palette. 
8. Kembali ke layer palette, pilih menu Layer | New Layer dengan nama 

“madvis”, pastikan layer baru ini sedang diedit. Pilih menu Edit | Fill, 
set “Use”’ ke “Black”. Ctrl+D (deselect). 

9. Pilih menu Layer | Duplicate Layer.. , pastikan “madvis” beserta 
duplikatnya sedang diedit dan pastikan juga checkbox ”preserve 
transparency” juga tidak terpilih. Selanjutnya pilih menu Filter | Other | 
Offset dengan nilai 2 dan 2. 

 

 
 

Membuat Button 
 

1. Pertama Tama Buat file baru fill dengan warna backgorund. kemudian 
buat layer baru. pilih tool elliptical marquee dan buat sebuaH lingkaran 
lalu di Fill. Di sini saya menggunakan warna coklat sebagai forEgorund 
dan background hitam. Anda bebas menentukan warna lainnya. 

2. Kemudian buat layer baru. pilih tool airbrush atur settingnya dengan 
diameter 18 pixel dan hardness 100% dan cat lah lingkaran tadi dengan 
warna putih. 

3. Kemudian berikan effek Gaussian blur dengan radius pixel. 
4. Langkah terakhir adalah mendeselect selection dan bola anda sudah 

selesai. anda dapat mengubah warnanya melalui menu 
Image/Adjust/Hue saturation. 
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Efek Dot 
1. Buka dokumemen baru, masukkan gambar atau tulisan yang ingin 

di effect. 
2. Untuk contohnya saya pilih gambar kamera. setelah itu saya kroping 

gambar tersebut, setelah itu pilih gambar tersebut penuh. 

3. Selanjutnya pilih menu Select > Modify > Expand dan tulis nilai 10 
lalu klik ok. tekan huruf d untuk membuat warna menjadi default. 

4. Lalu duplikat layer dengan membuat layer baru atau dengan 
mengcopynya. pilih layer yang baru dibuat.drag / tarik kebawah 
layer lama (dibawahnya)selanjutnya tekan alt + backspace. 

5. Tekan tombol q untuk mode mask. lalu pilih menu Filter >> Pixelate 
>> Color Halftone. Ulangi beberapa kali dengan ctrl + F (kalo saya 
dalam hal ini 5x) selanjutnya klik tombol q lagi untuk membuat mode 
mask hilang setelah itu terdapat selection yang bisa kita fill warna 
dengan menekan tombol alt+back space. 
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Macromedia Flash 
 

Area Kerja Macromedia Flash 
 

 
 
Di bawah ini merupakan keterangan dari kegunaan masing-masing komponen 
Flash MX secara detail: 
 
A. Timeline, digunakan untuk mengatur dan mengontrol isi keseluruhan 

movie Anda. 
 

 
 

B. Stage, merupakan tempat dimana Anda bekerja dalam membuat sebuah 
animasi. 
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C. Tools Box, berisi alat-alat yang digunakan untuk menggambar objek pada 

stage. 

 
Description of Tools Box: 

 Arrow Tool 
Tool ini digunakan untuk memilih suatu objek atau untuk 
memindahkannya. 

  Subselection Tool 
Tool ini digunakan untuk merubah suatu objek dengan edit points. 

  Line Tool 
Tool ini digunakan untuk membuat suatu garis di stage. 

  Lasso Tool 
Tool ini digunakan untuk memilih daerah di objek yang akan diedit. 

  Pen Tool 
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Tool yang digunakan untuk menggambar dan merubah bentuk suatu 
objek dengan menggunakan edit points (lebih teliti &  akurat). 

  Text Tool 
Tool ini digunakan untuk menuliskan kalimat atau kata-kata. 

  Oval Tool 
Tool yang digunakan untuk menggambar sebuah lingkaran. 

  Rectangle Tool 
Tool yang digunakan untuk menggambar sebuah segiempat. 

  Pencil Tool 
Tool ini digunakan untuk menggambar sebuah objek sesuai dengan 
yang Anda sukai. 
Tetapi setiap bentuk yang Anda buat akan diformat oleh Flash MX 
menjadi bentuk sempurna. 

  Brush Tool 
Tool ini sering digunakan untuk memberi warna pada objek bebas. 

  Free Transform Tool 
Tool ini digunakan untuk memutar (rotate) objek yang Anda buat atau 
mengubah bentuk objek menjadi bentuk lain. 

  Fill Transform Tool 
Tools ini digunakan untuk memutar suatu objek yang diimport dari luar 
lingkungan Flash 
MX, serta untuk mengatur efek warna. 

  Ink Bottle Tool 
Tool ini digunakan untuk mengisi warna pada objek yang bordernya 
telah hilang (tidak ada). 

  Paint Bucket Tool 
Tool ini digunakan untuk mengisi warna pada objek yang 
dipilih. 

  Eraser Tool 
Tool ini digunakan untuk menghapus objek yang Anda bentuk. 

 
 
D. Color Window 

merupakan window yang digunakan untuk mengatur warna pada objek 
yang       Anda buat. 
 
E. Actions – Frame 

Merupakan window yang digunakan untuk menuliskan Action Script untuk 
Flash MX. Biasanya Action Script digunakan untuk mengendalikan objek yang 
Anda buat sesuai dengan keinginan Anda. 
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F. Properties 

Merupakan window yang digunakan untuk mengatur property dari objek 
yang Anda buat. 

 
 
G. Components 

Digunakan untuk menambahkan objek untuk web application yang 
nantinya di publish ke internet. 
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DASAR–DASAR MENGGAMBAR OBJEK PADA 

FLASH MX  
 

Flash MX menyediakan berbagai macam tools dalam menggambar sebuah 
objek. Disini Anda diberikan kebebasan dalam menggambar suatu objek, objek 
yang Anda buat tergantung dari imajinasi Anda sendiri. 

 
Pengetahuan Dasar Objek Pada Flash MX  
Di dalam Flash MX terdapat berbagai macam objek yang sangat unik 
diantaranya yaitu oval tool (yang sering digunakan untuk menggambar sebuah 
lingkaran) dan rectangle tool (yang sering digunakan untuk menggambar 

sebuah bujur sangkar atau persegi panjang). Kedua tool tersebut bersifat paten 
yakni sudah menjadi bawaan Flash MX itu sendiri. Kedua objek tool tersebut 
(oval tool & rectangle tool) terdiri dari dua bagian yaitu: Outline dan fill. Outline 
merupakan bagian terluar dari objek tersebut, sedangkan fill merupakan 
bagian terdalam dari objek tersebut yang dapat diisi dengan warna atau 

gambar [Lihat gambar m].  

 
Gambar m. Fill & outline pada objek Flash MX  

Outline & Fill dapat disatukan dengan cara membuatnya menjadi satu grup, 
yaitu dengan perintah: Group (dapat dipilih melalui menu Modify > Group) atau 
dengan cara menekan tombol Ctrl+G secara bersamaan. Tetapi sebelum Anda 
menjadikan Outline & Fill menjadi satu grup yang harus Anda lakukan adalah 
memblok seluruh bagian Outline & Fill hingga terlihat seperti gambar m.1. Jika 
telah diblok maka Anda harus membuatnya menjadi satu grup dengan cara 

yang telah dijelaskan diatas.   

 

Gambar n.1. fill ungrouped Gambar n.2. fill grouped 
 
Membelah Objek dengan Line Tool  
Selain itu dalam pemotongan gambar melalui Flash MX tools sangatlah mudah, 
karena Anda dapat menggunakan berbagai macam cara. Misalnya dalam 
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memotong sebuah fill dengan menggunakan line tool.  

 
(i) (ii) (iii)  

Gambar o. (i) merupakan fill yang belum dipotong dengan line tool, (ii) merupakan 
fill yang dipotong 
dengan line tool, 

(iii) merupakan fill yang telah terbelah menjadi dua.    
 

Menggambar dengan Pencil Tool  
Dalam membuat sebuah objek, Anda dapat menggunakan tool yang terdapat 

pada Tools box, yaitu pencil tool.  

 

Jika Anda memilih Straighten maka objek yang Anda buat akan berbentuk 
bujur sangkar yang rapi. Tetapi jika Anda memilih Smooth maka objek yang 
Anda buat akan tampak halus garisnya meskipun tidak serapih straighten. 
Begitu pula dengan Ink bentuknya juga tidak serapih Straighten, tetapi yang 
membedakan antara Ink dengan Smooth adalah garisnya yang kurang 
halus(masih terlihat kasar). 
 
Menggambar dengan Pen Tool  
Pen tool biasanya digunakan untuk menggambar objek dengan metode edit 
points. Untuk menggambar sebuah objek, Anda tinggal menentukan posisi dari 

edit points yang Anda inginkan.  

 

 Edit points  
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Gambar p. objek dengan pen tool 

 
Mewarnai objek dengan Brush Tool  
Brush yang artinya sendiri adalah sikat/kuas. Tool ini digunakan untuk 
mewarnai sebuah objek secara keseluruhan. Ada 5 metode pemberian warna 
pada brush tool (lihat gambar dibawah ini).  

 

(i) (ii) (iii) (iv) (v) (vi)  

(i).Gambar asli, (ii).Paint normal, (iii).Paint behind, (iv).Paint selection, (v).Paint 
fills, (vi).Paint inside. 

 
Merubah Bentuk Objek dengan Arrow Tool  
Merubah dalam flash mx sangatlah mudah dan efisien. Untuk mengubah 
bentuk suatu objek Anda dapat menggunakan arrow tool. Dengan arrow tool 
Anda tinggal mengubah suatu objek dengan menggerakkan outline (garis objek) 
dari objek tersebut.  

 

Gambar q.a. merubah bentuk objek dengan arrow tool
 
Merubah Bentuk Objek dengan Subselection Tool  
Merubah bentuk suatu objek dengan menggunakan Subselection tool 
sangatlah mudah dan menyenangkan, karena dengan subselection tool Anda 
dapat merubah suatu objek tool menjadi suatu objek yang Anda inginkan. 
Lihat gambar dibawah ini yang telah dipilih dengan menggunakan subselection 
tool.  

 
Gambar q.b. merubah bentuk objek dengan subselection tool  
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Dengan menggunakan subselection tool maka objek diatas dapat diubah 

menjadi objek baru (seperti gambar dibawah ini).  

 

Gambar q.c.Objek yang telah diubah 
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Dasar – Dasar Pewarnaan Objek Pada Flash MX  

Untuk memberikan efek yang baik pada suatu animasi ada kalanya kita 
harus mengatur warna suatu objek agar terlihat menarik. Dalam pewarnaan 
suatu objek pada Flash MX kita dapat menggunakan berbagai macam tools, 
diantaranya yaitu:  

A. Color Mixer.  
B. Color Swatches.  
C. Paint Bucket Tools.  
D. Ink Bottle Tools.  
E. Brush Tools.  
F. Fill Transform Tools. (Untuk mengatur efek warna radial) Jika Anda 

menginginkan animasi yang Anda buat mempunyai tampilan menarik dan 
indah, maka Anda harus memberi efek warna yang baik pula. Oleh karena 
itu kali ini kita akan belajar bagaimana memberikan efek warna pada suatu 
objek agar terlihat lebih indah.  

Memberi warna dengan Color Mixer & Color Swatches  
Untuk memberi efek warna pada objek pada Flash MX hanya membutuhkan 
2 color tool, yaitu: Color Mixer & Color Swatches. Saat ini kita akan 

membahas tentang bagaimana cara menggunakan tools tersebut.  

 

  Gambar q.1. Color Mixer  

Didalam Color mixer terdapat 5 macam type fill:  

1. None – tidak memberi warna apapun pada fill.  
2. Solid – memberi warna padat pada fill.  
3. Linier – memberi warna berbentuk linier pada fill.  
4. Radial – memberi efek warna radial pada fill.  
5. Bitmap – memberi image pada fill. (untuk mengimpor file gambar 
gunakan import to library pada file menu). Untuk memberi warna pada 
objek yang ditentukan, Anda harus menggunakan tools yang bernama paint 
bucket tool. Biasanya yang diberi warna pada object ialah fill-nya saja. 
Untuk memberi warna pada outline, Anda harus menggunakan ink bottle 
tool. Pada pojok kanan window color mixer terdapat R, G, B (yang biasa 
disebut sebagai penentu warna). R(Red) digunakan untuk memberi nilai 
seberapa besar kemerahan warna objek tersebut. G(Green) digunakan 
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untuk memberi nilai seberapa besar kehijauan warna objek tersebut. 
B(Blue) digunakan untuk memberi nilai seberapa besar kedalaman warna 
biru pada objek tersebut. Alpha memberi efek warna transparan pada objek 
yang dituju.  

 
Gambar q.2. Color Swatches  

Pada color swatches untuk memberi warna pada object prinsipnya sama 
saja dengan color mixer, yang membedakannya yaitu kalau pada color mixer 
Anda dapat mencampurkan berbagai warna sekaligus memodifikasinya 
menjadi suatu efek warna sesuai dengan keinginan Anda. Tetapi kalau pada 
color swatches efek warna sudah ditentukan oleh system. Melalui color 
mixer Anda dapat membuat warna baru di color swatches. 

 
Mengatur Tata letak warna pada Objek  
Untuk mengatur tata letak warna pada objek dapat menggunakan tool yang 
bernama Fill Transform Tool. Cara menggunakannya yaitu:  
1. Pilih seluruh area dari objek tersebut. Kemudian pilih Fill Transform Tool 
dari Tools Box.  
2. Setelah itu klik kembali objek yang akan diatur warnanya. 
Maka hasilnya akan seperti gambar dibawah ini.  
 
 

 
Gambar q.3. Object yang diatur warnanya  

Selain cara-cara diatas Anda masih dapat mengontrol warna lewat tools box. 
Hanya saja warna pilihan untuk outline beserta fill bersifat solid. Kunci 
kesuksesan dalam membuat suatu animasi bersifat interaktif terletak dalam 
pengaturan warnanya. Jika Anda memberikan warna yang solid saja pada 
animasi Anda maka animasi yang Anda buat tersebut akan terlihat kurang 
menarik. Karena itu efek warna sangat diperhitungkan dalam pembuatan 
suatu animasi.  
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LAYER - informasi umum mengenai layer 
 
Bila anda bayangkan, layer adalah semacam lapisan plastik transparan 
yang dapat kita letakkan bertumpukan dengan masing-masing plastik 
transparan tersebut mengandung elemen tersendiri, sehingga memudahkan 
kita untuk mengorganisasikannya. 
 

 
 
Angka 10, 20, 30, dan seterusnya pada bagian atas gambar merupakan 
timeline, atau penanda waktu. Jadi sederhananya, bila pada detik ke-10 
dan layer satu anda letakkan elemen gambar tertentu, gambar itu hanya 
akan terlihat pada satuan waktu ke-10 dari movie anda. Pengertian tentang 
penanda waktu atau timeline ini sangat penting dan berperan pada 
penguasaan kita pada Flash. 
Keseluruhan garis putih horizontal pada sisi sebelah kanan tulisan layer 
adalah frame-frame yang akan muncul secara bergantian sepanjang waktu 
yang anda tetapkan. Movie anda didasarkan pada frame-frame, nilai 
defaultnya 12 frame per detik, 12 f/s, berarti kecepatannya 12 frame 
perdetik. 
 
 Untuk merubah nama layer kita dapat memilih layer dengan mouse 
kemudian double klik atau tekan enter, lalu masukkan nama layer untuk 
memudahkan pengorganisasian movie. Setiap layer sebaiknya mengandung 
satu obyek atau grup karena animasi hanya dpat dilakukan satu 
obyek/grup per layer. 
 Urut-urutan layer dapat kira rubah dengan men-drag menarik layer, 
ke atas dan kebawah, layer yang tampil di atas adalah yang terlihat lebih 
dahulu saat movie berjalan. Sebagai contoh, bila anda menginginkan satu 
movie dengan latar belakang hitam pada layer 1, dan tulisan teks pada layer 

2, namun anda terlanjur membuat layer tersebut (insert layer) secara 
terbalik, anda tinggal menarik layer 1 ke bawah. Mudah bukan ? 
 Pada Flash 4 dengan klik kanan pada layer bar, kita dapat merubah 
properti dari layer tersebut, menambah, menghapus, mengganti nama, 
menyembunyikan, mengunci, dan lain-lain. Pada Flash 3 kita dapat 
melakukan ini dengan klik pada sebuah button kotak di sebelah layer bar. 
 
  
MODE PADA LAYER 
Sangat penting untung mengerti mode yang dapat diterapkan pada layer, 
karena akan mengurangi banyak frustasi anda saat akan membuat movie. 
 
Di antara mode-mode tersebut antara lain : 
 
 Current Mode, memiliki pengertian bahwa layer tersebut merupakan 
layer tempat anda bekerja saat ini, sehingga segala perubahan yang anda 
terapkan pada leyer lain akan diabaikan, untuk Flash 4 hal ini telah 
diperbaiki dengan mengasosiasikan setia frame dan obyek yang anda klik 
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untuk langsung berubah menjadi current layer. 
 Normal Mode,bila layer tersebut pasif dan tidak ada apa-apa yang 
dimodifikasi saat itu. 
 Locked Mode, bila layer tersebut ingin kita kunci sehingga modifikasi 
yang kita lakukan pada layer sekitarnya tidak mengganggu are layer 
tersebut. Hal ini memudahkan anda untuk merubah surrounding dari layer 
tanpa mengganggu hal-hal yang saat itu telah anda fixed. Contohnya bila 
terdapat jajaran kotak, yang masing masing terletak pada layer yang 
berbeda dan anda ingin agar kotak kedua (yang telah baik posisinya) tidak 
berubah, namun anda ingin menggeser semua kotak lainnya sedikit ke 
kanan misalnya, gunakan Locked Mode pada layer tersebut. 
 Hidden Mode, bila anda ingin berkonsentrasi pada suatu obyek, dan 
ingin agar yang lain tersembunyi anda dapat menggunakan mode ini 
sehingga perubahan yang anda lakukan bisa lebih cepat dan mudah serta 
akurat. Contoh apabila anda telah mengorganisir puluhan animasi yang 
simpang siur dan hendak menyembunyikan mereka agar anda dapat 
meletakkan sebuah teks pada sudut kanan bawah dengan baik, gunakan 
Hidden Mode. 
 
 

FRAME - informasi umum mengenai frame 
 
Frame berarti adegan, berarti satu frame pada movie anda melambangkan 
satu potongan adegan, yang akan menyusun keseluruhan animasi atau 
movie anda. Setiap frame memiliki properti, yang menentukan bagaimana 
frame tersebut menyusun movie. Keyframe berarti frame kunci anda dapat 
meletakkan obyek pada keyframe (berlambang titik hitam) 

 
Istilah-istilah mengenai frame : 
 Keyframe dengan actions, keyframe yang memiliki actions berarti 
keyframe tersebut akan memanggil sebuah kode yang kita tentukan dari 
modul yang tersedia. Beberapa diantaranya yakni, go to, play, get url, stop, 
tell target, if frame is loaded, dll. Pelan-pelan saja, semua istilah diatas akan 
dijelaskan di bagian lain...:) 
 Frame dengan motion tween, jenis ini akan banyak anda jumpai. Ini 
berarti bahwa diantara dua keyframe, Flash dapat mengambil perhitungan 
otomatis secara gerak dan skala tentang isi dari frame yang ada di 
antaranya dan akan menciptakan sekuens gerak atau animasi. Perhatikan 
bahwa motion tween ini hanya bisa dilakukan untuk obyek yang berupa 
symbol atau grup dan hanya dapat berlaku pada satu obyek setiap layer. 
Pada Flash 4 dilambangkan dengan warna biru muda. 
 Frame dengan shape tween, berarti bahwa tweening dilakukan untuk 
obyek diantara dua keyframe berupa morphing dari benda yang bukan 
symbol atau group. Shape tween hanya berlaku untuk obyek yang telah 
broken apart, ctrl + b shortcut. 
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 Frame kosong , kalau setelah sebuah keyframe terdapat rangkaian 
frame yang kosong, maka movie akan menampilkan image atau obyek 
terakhir pada keyframe sebelumnya. Hal ini dapat anda terapkan untuk 
membuat sebuah background yang statis dengan animasi pada layer bagian 
atasnya. 
 Sound Frame , pada setiap keyframe dapat anda sertakan 
suara/sound, dengan double klik, pilih frame properties, kemudian pilih tab 
sound. Sebelumnya anda telah mengimpor file sound dengan ekstensi wav. 
Semacam grafik akan muncul untuk melambangkan adanya sound pada 
frame tersebut. 
 Insert Frame, kita dapat menyelipkan rangkaian frame sekaligus 
dengan memilih frame tab sekaligus, katakanlah dari timeline 10 hingga 25, 
dari layer 1 hingga 3, kemudian setelah highlight muncul, kita klik kanan 
dan pilih insert frame, there you go. 
 Insert Blank Keyframe, kita menyelipkan sebuah keyframe kosong, 
berguna untuk menghentikan animasi pada layer tersebut. Sebagai contoh, 
bila anda ingin agar animasi pada suatu layar berhenti pada frame ke 25 
maka anda klik kanan, dan pilih insert blank keyframe. 
 Reverse Frame , berarti membalikkan urutan frame. Sangat berguna 
untuk menimbulkan kesan reversi, misalnya sebuah tabel muncul perlahan 
dari bawah ke atas, setelah di klik anda menginginkan efek bahwa tabel 
tersebut perlahan kembali ke bawah. Anda tidak perlu membuat lagi motion 
tween yang baru cukup dengan copy frames yang mengandung sekuens 
muncul, paste pada tempatnya, kemudian highlight dan pilih reverse 
frames...done. 
 

SIMBOL - SENJATA UTAMA FLASH 
 

 
Simbol atau Symbols adalah keunggulan utama dalam Flash. Simbol 
merupakan gambar atau obyek apapun yang kita definisikan sebagai simbol 
(pilih dan tekan F8), untuk dapat kita pergunakan dan modifikasi berulang 
kali tanpa harus menambah ukuran file dan menduplikasi simbol tersebut 
untuk kegunaan lain. Dengan simbol yang terorganisir dengan baik kita 
dapat menyusun sebuah animasi spektakuler dengan sesedikit mungkin 
sakit kepala. 
 Jenis Simbol ada tiga, graphic, button, dan movie clip. Keseluruhan 
sumber daya baik itu sound, raster image, graphic, button, dan movie clip, 
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yang kita miliki dikelola dalam sebuah Library. Pada Flash 4 dengan mudah 
kita mengambil sebuah obyek dari library dan menempatkannya di stage, 
kelola dengan baik seperti kita mengelola file pada explorer, gunakan 
direktori. 
Untuk meng-edit simbol tersebut kita klik tombol paling kanan atas dari 
stage (terlihat pada gambar) dan sebuah dialog menu akan muncul, kita 
pilih simbol yang hendak kita edit. Dari Library Window (lihat gambar) hal 
tersebut juga dapat kita lakukan dengan double klik pada item yang 
dimaksud. Kemudian pilih edit symbol. 
 Pada Library kita dapat melihat preview dari symbol yang kita pilih, 
dan untuk button, sound, dan movie clip terdapat menu yang akan 
memutar secara preview apa isi dari button, sound, dan movie clip tersebut 
(di bawah tulisan options pada window library) 
 Untuk kembali dari area edit symbol pada flash empat di sebelah kiri 
tombol symbol (pojok kanan gambar) terdapat tombol lain yang 
melambangkan scene. Pilih Scene tempat anda bekerja dan kembali 
menyusun movie. 
Kelebihan lain dari simbol adalah bila anda melakukan editing pada simbol 
tersebut perubahan yang terjadi akan berlangsung di keseluruhan simbol 
yang anda telah taruh pada movie anda. Bayangkan anda menggunakan 26 
button dan ada cacat sedkit pada button tersebut, setelah anda edit anda 
tidak perlu repot-repot merubah 25 buttons lain yang ada di stage...hebat 
bukan ?!?! 
 Jangan kaku dalam menggunakan simbol karena sebuah graphic 
simbol dapat digunakan dalam button, demikian juga sebuah button dapat 
digunakan dalam sebuah movie clip (pengelolaan simbol lebih lanjut). 
Sebuah rangkaian button (katakanlah 25) dapat anda buat dalam sekejap 
dengan menggunakan duplicate (pada library window), anda hanya perlu 
merubah elemen yang berbeda katakanlah teks misalnya, maka berapapun 
button yang akan anda buat tidak akan menyita waktu terlalu 
 
 

TWEENING - informasi umum mengenai animasi  

Tweening, sangat 
mempermudah kerja kita 
untuk melakukan animasi, 
karena flash dapat 
meprediksi (dengan 
parameter yang kita 
masukan) bagaimana isi 
dari frame di antara kedua 
keyframe yang kita 
tentukan. Secara garis 
besar terdapat dua jenis, 
yakni motion, dan shape.  

 

 

 Gambar di sebelah kanan, merupakan 
hasil dari animasi tweening di atas. 
Sesuai dengan urutan dari atas ke 
bawah, jadi yang paling bawah adalah 
motion tween, dan yang paling atas  
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adalah shape tween. 

 Shape Tween , dengan toolbar yang 
telah disediakan kita dapat membuat 
sebuah box dengan warna apapun, dan 
kita letakkan pada keyframe 1, kemudian 
pada timeline 8 kita insert keyframe (F6), 
lalu kita buat sebuah lingkaran dengan 

posisi di tengah movie. Kemudian, kita 
double klik antara keyframe 1 dan 8, 
maka akan muncul dialog menu, kita 
pilih tweening. 
Kemudian pilih shape, maka jadilah 
animasi anda yang pertama, sebuah box 
yang perlahan berubah menjadi 
lingkaran berwarna biru, animasi 
berikutnya pada frame 8 hingga 15, 
sama. Anda insert keyframe pada 
timeline 15, buat bentukan segitiga, isi 
dengan warna merah kemudian klik 
kanan diantara frame bar, pilih frame 
properties dan pilih shape. 

 

 Shape Tween, atau tweening apapun sebenarnya sama dengan rangkaian 
keyframe seperti terlihat pada animasi baris kedua. Perhatikan frame bar, 
dari frame 1 hingga 15 terdapat jajaran keyframe yang setiap keyframenya 
menentukan bagaimana posisi obyek pada saat itu. Cara ini hanya efektif 
bila antara keyframe satu dengan yang lainnya berisi obyek yang tidak 
berhubungan, namun bila kita ingin menciptakan efek sekuensial, maka 
gunakan tween, lebih cepat dan ukuran file lebih kecil. 

 

 

Semua animasi dan gambar 
pada tutorial ini saya gunakan 

format gif, untuk 
memungkinkan anda semua 
melihat efek yang ditimbulkan 
tanpa perlu melakukan 
download plug in. Oleh karena 
itu ukuran file terutama animasi 
sedikit membengkak dan anda 
menunggu lebih lama. Tapi saya 
berusaha untuk mengurangi 
ukuran file hingga toleransi 
antara waktu load dan kualitas 
tercipta. Mohon maaf atas hal 
tersebut.  
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 Motion Tween ease out, untuk proses motion tween, perhatikan animasi 
baris ketiga dan keempat. Pembuatannya sama dengan shape tween, 
namun obyeknya telah kita rubah menjadi simbol (pilih obyek, tekan F8). 
Pada keyframe 1 posisi obyek di sebelah kiri dan key frame 15 saya geser 
ke kanan. Lalu diantara frame bar, kita double klik, pilih frame properties, 
pilih tweening, lalu pilih motion. Untuk animasi ini kita atur bahwa obyek 
easing out, perhatikan, pertama-tama dia melaju cepat (lebih cepat dari 
animasi bawahnya bukan ?), kemudian menjelang akhir obyek melambat 
dan berhenti di waktu yang sama dengan animasi baris empat. Lalu kita 
bisa tentukan obyek berotasi atau tidak, pada animasi ini, kita set rotation 
clockwise, lalu isi 1 pada times. 

 Motion Tween , animasi baris empat adalah motion tween biasa, dengan 

tanpa easing in atau out, dan tanpa rotasi. Perhatikan bahwa obyek 
bergerak konstan dari kiri ke kanan. Bila obyek pada keyframe 15 
membesar ukurannya kita dapat menerapkan tween scaling (check pada 
tween scaling) sehingga dengan motion tween kita dapat melakukan 
sekuens perubahan posisi, skala dan ukuran, serta warna. Shape tween 
relatif lebih kecil efeknya pada ukuran file dan penggunaan CPU, sehingga 
lebih sering digunakan. Efek yang dapat anda timbulkan sangat beraneka 
ragam oleh karenanya kuasai proses tweening ini dengan baik. 

 
 
 
 
 
 
 

Mulai Bekerja dengan Flash 
 

Animasi Bergerak  

Sekarang Anda akan mempelajari jenis animasi yang paling sederhana, 
yaitu benda bergerak. Pertama-tama seperti biasa, gambarlah sebuah 
bangun. 

 

Kemudian ubahlah objek tersebut (dalam hal ini segitiga itu) menjadi 
symbol graphic. Kemudian, klik frame 20 pada timeline di layer tersebut, 
dan masukkan sebuah keyframe (F6). 

 

Klik pada frame 20. Pindahkan gambar segitiga itu ke mana saja. 
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Setelah itu klik kanan pada timeline di mana saja di antara frame 1 dan 
frame 20 pada layer segitiga itu, dan pilih 'Create Motion Tween'. 

 

 

 

Animasi Rotasi dan Berskala 

Ini adalah salah satu animasi favorit saya, dan saya gunakan dalam situs 
pribadi saya. Banyak orang yang bertanya-tanya bagaimana membuatnya, 
padahal sangatlah mudah. Mari saya tunjukkan! Pertama buatlah objek 
yang ingin Anda animasikan. Dan jangan lupa untuk mengubahnya ke 
dalam symbol graphic. 

 

Kemudian seperti tadi pada Animasi Bergerak, buat sebuah keyframe di 
frame 20, dan 'Insert Motion Tween' di antara frame 1 dan 20. Klik 

Window>Inspectors>Transform, dan window di bawah ini akan muncul. Klik 
frame 20 dan pilih symbol yang akan Anda animasikan. Masukkan 400 
pada scale, dan 180 pada rotate. 
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Animasi Warna 

Animasi warna sering digunakan untuk efek cahaya. Misalnya tulisan yang 
muncul dengan tiba-tiba. Oleh karena itu kali ini kita gunakan tulisan 
sebagai contohnya. Buatlah tulisan seperti di bawah ini, kemudian ubah 
menjadi symbol graphic. 

 

Masukkan keyframe dalam frame 20 dan frame 40. 'Insert Motion Tween' di 
antara kedua frame tersebut. Klik frame 20, kemudian klik dua kali pada 
objek yang bersangkutan. Window 'Instance Properties' akan muncul. Klik 
tab 'Color Effect'. Kemudian pilih 'Tint' dari menu dropdown. Pilih warna 
merah, dan set 'Tint Amount' sampai maksimal. Klik 'OK'. 

 

Klik pada frame 40, kemudian klik dua kali pada objek yang bersangkutan. 
Pada tab 'Color Effect', pilih 'Alpha' dari menu dropdown, dan set pada 0%. 
Alpha ini berguna untuk efek transparansi. 

 

 

Masking 

Sebelum saya menerangkan cara membuat efek masking, Anda tentu harus 
tahu apa tujuan efek masking ini. Seperti namanya, efek masking berguna 
untuk menutupi sebagian dari movie. Oh, masih tidak mengerti? Mari kita 
lanjutkan latihan. Kali ini kita akan membuat masking tulisan. Buatlah 
tulisan seperti biasa. Anda tidak perlu mengubahnya menjadi symbol 
kecuali bila Anda ingin menganimasikannya. 
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Klik pada frame 20 dan 'Insert Frame' (F5). Klik pada nama layer, kemudian 
Insert>>Layer, atau 'Add Layer' untuk membuat layer baru di atas layer 
tulisan tadi. Klik kanan pada nama layer baru tersebut, dan pilih 
'Mask'.Anda tentu melihat bahwa layer baru tersebut menjadi terkunci. Klik 
pada icon gembok untuk membuatnya dapat diedit lagi. Ingat bahwa objek 
yang akan di mask harus langsung berada di bawah layer mask. 

 

Klik frame 1 pada layer mask, kemudian gambar sebuah lingkaran. Ubahlah 
lingkaran itu menjadi symbol graphic. 

 

Kemudian 'Insert Keyframe' pada frame 20, dan geser lingkaran tersebut ke 
sisi kiri. Jangan lupa untuk 'Create Motion Tween' antara frame 1 dan 20. 

 

 

Animasi Bentuk 

Animasi bentuk sedikit berbeda dari animasi lainnya karena sebelum 
dianimasikan, objek tidak perlu diubah menjadi symbol. Mari kita coba. 
Gambar sebuah bentuk, tapi jangan diubah menjadi symbol. 
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Masukkan keyframe pada frame 20. Klik frame 20. Modifikasi objek Anda 
dengan tool select. Caranya yaitu dengan klik serta drag bagian tepi dari 
objek Anda. 

 

Klik dua kali di mana saja pada timeline di antara frame 1 dan frame 20. 
Akan muncul window Frame properties. Klik pada tab 'Tweening', kemudian 
pilih 'Shape Tweening' dari dropdown menu. 

 

 

TOMBOL – BUTTONS 
 

Membuat tombol dengan animasi dalam Flash sangat mudah. Pertama-tama 
buatlah sebuah tombol. Dalam contoh ini saya membuat gambar lingkaran 
sederhana, dengan tool circle dan fill gradient. 

 

Ubahlah gambar ini menjadi symbol button. Caranya adalah dengan 
menekan tombol F8, mengklik pilihan 'button', dan klik 'OK'. Sesudah 
gambar tersebut menjadi symbol, klik kanan pada gambar itu dan pilih 
'Edit'. Pada timeline akan muncul timeline baru dengan set keyframe untuk 
tombol. 
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Masukkan keyframe pada label 'Over' dan 'Down' seperti pada gambar di 
atas. Kemudian klik pada keyframe 'Over', dan kemudian saya mengubah 
gambar lingkaran saya menjadi seperti ini. 

 

Kemudian klik pada keyframe 'Down', dan kemudian saya mengubah 
gambar lingkaran saya menjadi seperti ini. 

 

TOMBOL2 

 

Buttons, merupakan asset yang menunjukkan betapa interaktifnya Flash. 
Semula memang kelihatan sedikit rumit, tapi percaya deh, buttons ini kalau 
kita telah latihan sedikit akan sangat mengasikkan. 
Bila anda tekan F8 maka akan ada dialog new symbol, pilih buttons untuk 
menciptakan satu tombol. Terdapat 4 State atau keadaan pada button yang 
bisa kita gunakan agar button lebih menarik. Kondisinya sama yakni 
dengan layer kita bisa meletakkan lebih dari satu item pada button. State 
itu antara lain Up State, Over State, Down State, dan Hit State. 

 

UP State, 
adalah kondisi button sepanjang movie, 
normal dan tidak mengalami perubahan 
apa-apa. 
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OVER State, 
adalah kondisi button bila mouse berada 
di atasnya, dapat berupa perubahan 
warna, suara dan lain-lain. 

 

DOWN State, 
Bila user menekan dan melepas mouse 
pada button, tidak perlu selalu ada 
namun akan sangat manis ditambahkan 
untuk lebih menunjukkan interaktivitas. 

 

HIT State, 
merupakan area panas dari tombol, 
katakanlah anda menginginkan hanya 
bagian tertentu dari button yang 
menimbulkan efek button, bila pada HIT 
state anda selipkan keyframe maka 
pastikan bahwa area tersebut tidak 
kosong karena akan menyebabkan 
tombol anda tidak akan berfungsi. 

MEMBUAT TOMBOL BERANIMASI 

 Kita harus telah memahami movie clip, untuk membuat sebuah tombol 
beranimasi, atau animated buttons. Namun prinsipnya tidak berbeda 
dengan tombol regular. 

 Misalnya kita hendak memunculkan sebuah animasi berupa asteriks 
yang berputar di latar belakang tombol pada Over State. 

 Buat sebuah Simbol berupa Movie Clip (diantara tiga menu pada dialog 
setelah anda tekan F8, pilih movie clip), animasi dibentuk dengan 
menggunakan tweening motion. 

 Kembali pada simbol button anda, dan selipkan/insert layer di bawah 
tombol tersebut, dan biarkan Up State dalam kondisi kosong. Pada Over 
State insert Keyframe (tekan F6). Insert (drag) movie clip animasi tadi ke 
bawah button, rapihkan posisinya dengan titik cross hair , dan biarkan 
kosong pada down state dan hit state layer ini. 

 Selesai, (gampang bukan ?), berbagai variasi dapat kita terapkan pada 
metode ini. Ketika mouse berada di dalam area panas, animasi akan 
berjalan, dan berhenti saat mouse keluar. 

 


